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VISION 101 

 

 
This guide walks you through VISION 8.8 introducing logging in and out, navigation 

steps, icons and links, and accessing queries and reports. 
  All users should complete this guide first. 
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Revisions to Manual 
October 2016 

 Manual rewritten 
 

March 2012 
 Breadcrumb Navigation & Menu Layout 
 Server Selection  

 When setting run control parameters, you no longer need to select a PSNT/PSUNX/PSUNX2 

server. Before the upgrade, if you didn't select a server the job would stay queued. Now a 
server drop down list isn't available. All existing run controls will have the server removed. 

 Main Menu Sort Feature 
 "Processing" Message Change  

 The red flashing "Processing" message that appeared in the upper right hand corner has 

been replaced by a square box with a processing circle. (The processing circle looks very 
similar to the one on an Internet Explorer 8 tab when a webpage is loading.) The 

processing box is smaller than the current "Processing" message and is located to the right 
of the "Help" link. 

 New Window Quirk 
 Quick clickers beware. When opening a 'New Window' from a VISION session, wait until 

the page completely loads until maximizing the screen. Maximizing before the new window 
has loaded will cause the new window to be incomplete. If this happens, simply close 

the window and try again. 

 File>New Session - NOTE:  If you are using Internet Explorer 7, this feature will not work. 
 This feature is important if you login to VISION and/or ESS and/or HCM at the same time. 

Use Internet Explorer’s File>New Session option to open a new window instead of using a 

new tab.  Without using New Session, if you are logged into VISION and decide to check 

your pay advice, for example and you sign into ESS in a new tab, you will be logged out of 
VISION.  To avoid this, use New Session.  Instructions are located on the VISION System 

page. 

 Chartfield Definitions 
 Now includes information on the following chartfields:  Fund, Dept ID, Program, Class, 

Project. 
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System Overview 

VISION-Financials is an Oracle/PeopleSoft enterprise financial management system 
utilizing the following modules: General Ledger, Accounts Payable, Purchasing, 
Accounts Receivable, Billing, Asset Management, Inventory, Travel & Expense, and VT 
Grant Tracking (VT custom module). The system is managed by the Dept of Finance & 
Management in conjunction with the Dept. of Information & Innovation's PeopleSoft 
Technical Unit 
  

 

System Availability -VISION Financials Production is available daily from 6:00AM to 
7:00PM 

A “Sandbox” environment is available. “Sandbox” will be refreshed daily, exactly like 
VISION Reporting use to be. The purpose of “sandbox” is to be able to do production-
like things without impacting Production. You may use this environment to train, test 
the impact of adjustments, etc.  Do Not Use “sandbox” for reporting. 
 

VISION Support 
Available from 7:45am to 4:30pm 
Call: (802) 828-6700, Option 2 or email VISION.FinHelpdesk@vermont.gov   

mailto:VISION.FinHelpdesk@vermont.gov
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Logging into VISION 8.8  
 

VISION Financial Production login link can be found at the Department of Finance & 
Management webpage or at the link below: 
https://finance.erp.state.vt.us/psp/FMPRD/?cmd=login&languageCd=ENG&. 
 

 New users will need to work with their Department Business Manager to obtain a 
User Id and temporary password. 

 Login information should never be shared with anyone.  

 Users need to set up the I Forgot My Password help ahead of time to be able to use 
it.  See the Set up Forgotten Password Help and Email on page 9 for instructions. 

 The system will lock an account after three unsuccessful login attempts and the I 
Forgot My Password help will not work.  If you lock your account, contact VISION 
support at VISION.Finhelpdesk@vermont.gov. 

 
 
 

 
 

Click on the VISION Login link: 

https://finance.erp.state.vt.us/psp/FMPRD/?cmd=login&languageCd=ENG&
mailto:VISION.Finhelpdesk@vermont.gov
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The VISION Financials Production login page is displayed. 

 Enter User ID – Typically it is the First letter of your first name followed by up 
to the first 7 characters of your last name in UPPERCASE. Some users might also 
have a number at the end of the user ID. 

 Enter Password - 
Password Requirements 

 Passwords are case sensitive 

 You can’t use the same password more than once 
 Must be at least 8 characters long  
 Must contain at least one digit 
 Expires every 90 days 
 The login screen will display a notification 10 days prior to the 

password expiring 
 

 Click on the Sign In button  
 
If you are a new user or your password has expired, you will be prompted to 
change your password. 
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Click the link “Click here to change your password”.  If the window doesn’t direct you to 
the change password page, close the window and try logging in again. 

 

 Enter Current Password – Enter the password you used on the login screen. 

 Enter New Password - 
Password Requirements 

 Passwords are case sensitive 
 You can’t use the same password more than once 

 Must be at least 8 characters long  
 Must contain at least one digit 
 Expires every 90 days 
 The login screen will display a notification 10 days prior to the 

password expiring 

 Enter Confirm Password.  Reenter the new password. 
 Click on the Change Password button  
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Click the “Click to return to signon page” link and login with your User Id and new 
password. 

What to do if you are having difficulty logging in: 

1.  Verify you are on the VISON login page located on the Department of Finance and           
Management webpage. 

2.  Check your User Id.  VISION logins are the first letter of your first name followed by up 
to the first 7 characters of your last name in UPPERCASE. Some users might also have a 
number at the end.   

3.  Clear Cache:  press CTRL, SHIFT and DELETE (all at the same time) on the login page 
and delete browsing history. Then close all browser windows and try again.   

4.  Contact VISION Support by email:  vision.finhelpdesk@vermont.gov or call 802-828-
6700 Option 2 

  

mailto:vision.finhelpdesk@vermont.gov?subject=I%20need%20help%20logging%20into%20VISION
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Set up Forgotten Password Help and Email 

 

Each user must set up forgotten password help.  This feature allows a user to reset the 
password through email by clicking "I Forgot My Password" on the login screen. 
 
The forgotten password link should be used after the 2nd login attempt.  After the 3rd 
attempt, your account will lock and the password that is emailed to you will not work.  
To unlock your account, you will need to contact VISION Support 
by email:  vision.finhelpdesk@vermont.gov or call 802-828-6700 Option 2 
 

Step Action 

 

1. Click the Main 

Menu button. 

 

 

mailto:vision.finhelpdesk@vermont.gov?subject=I%20need%20help%20logging%20in
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Step Action 

 

1. Click on My System 

Profile. 

 

 

Step Action 

 

2. Click the Change or set 

up forgotten password 

help link. 
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Step Action 

 

3. Click the Question drop 

box to see a list of 

available options. 

 

 

Step Action 

 

4. There are 4 questions 

to choose 

from.  Choose the 

question that works 

best for you.  
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Step Action 

 

5. Enter your response to 

the security question.  

 

Step Action 

 

6. Click the OK button. 
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Step Action 

 

7. To see the email 

section, 

 

Scroll down the 

screen using the 

scrollbar. 

 

 
This e-mail address is very important!  This is the email address the system uses to 
send expense notifications and a new password when using the “I forgot my password” 
link. 
 

Step Action 

 

8. Select the Primary 

E-mail 

Account option. 

 

Step Action 

9. Choose Business 

from the E-mail 

Type drop down 

list. 

 

 

Step Action 

10. Enter your email 

address into the 

Email Address 
field. 
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Step Action 

 

11. Click 

the Save button. 

 

 

After completing these steps, if you click on the "I Forgot My Password" link on the 
login page, you will be prompted to answer to your challenge question. After correctly 
answering this question a temporary password will be emailed to you.  The temporary 
password is case sensitive and must be entered in the password field exactly as it was 
emailed. 
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Change Password 

 
Passwords can be changed by going to My System Profile or by clicking the 
Change My Password link on the VISION home page. 

 
 
The Change Password page will be displayed;  

 

 Enter Current Password – Enter the password you used on the login screen. 

 Enter New Password - 
Password Requirements 

 Case Sensitive 
 You can’t use the same password more than once 
 You will have ten days to change expiring passwords 
 Must be at least 8 characters long  
 Must contain at least one digit 
 Expires every 90 days  

 Enter Confirm Password.  Reenter the new password. 
 Click on the Change Password Button  
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Click the “Click to return to signon page” link and login with your User Id and new 
password. 
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System Navigation 

 
VISION Version 8.8 is a web based application that uses many standard web browser 
features such as menus, drop down selection lists, icons, links, etc. The menu options 
you see will differ based on the security access appropriate for your job functions. 
 
All Navigation should occur using the application menus and links and not by using the 
web browser back button.  Using the web browser to navigate can cause the system to 
error and you will lose any unsaved data.  
 

 
 
 

 
 

WARNING 

Do not use the browser “back” 

button to navigate within 

VISION. All navigation 

should occur within the 

application  

X 
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How to use the Main Menu 
 

VISION features a Main Menu on the top navigation bar.  Clicking on “Main Menu” will 
open up an expandable drop down menu list.   
 

 
 

 
 

  

 A folder icon  to the left of the 

menu item indicates the menu item 

can be expanded.  Click the menu item 

to open up the next level of menu 

options or pages. 

 Menu can be sorted alphabetically by 

clicking on the sort arrows 

 A blue file icon  to the left of the 

menu item indicates the item is a page.  

Clicking the item will bring you directly 

to the page.  



 Page 19 of 62 

 

 
Example of navigating to add/update voucher using main menu:  
 
Navigation: Main Menu>Accounts Payable > Vouchers> Add/Update >Regular Entry 
 

 
 
Click the Accounts Payable menu item 
 

 
 
Click the Vouchers menu item 
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Click the Add/Update menu item 
 

 
 
Click Regular Entry menu item 
 
The Voucher Regular Entry page will display 
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Breadcrumb Menu Feature 
The top navigation bar will keep the navigation used to reach a page as a “breadcrumb” 
menu.   

 
 
Click on any of the “breadcrumb” menu items to expand the available menu options. 
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My Favorites 
Favorites can be added to quickly navigate to specific pages in VISION.  Once a page is 
saved as a favorite, it will be available in the Favorites Menu.   
 

 
 
Navigate to any page you would like to save as a favorite and click the Add to 
Favorites link. 
 

 
 
Enter a Description to display under the Favorites Menu.   
 
Click OK to Save Favorite 
 
NOTE: Adding a page to “My Favorites” as directed above adds it to VISION ONLY – do 

not confuse these with Favorites on your internet browser. 

Favorites Menu 
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Page Navigation 

 

  
 
 
The above screenshot demonstrates several common navigation features.  
 

1. Tabbed pages – displayed as folder tabs 
2. Links – displayed as blue underlined words 
3. Buttons – action keys displayed as boxes 

 
 
 

1 

 

2 

3 
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Search Features 
As you select different modules and activities, often a search screen is presented to find 
an existing value or to enter a new value. When using “Find an Existing Value”, use all 
search options available to return the desired results. Below are some search tips. 
 

 

 
 

 In the drop down box, select contains to avoid needing to enter leading zeros. 
 Enter as much information as you KNOW is accurate. This will return results that 

match known criteria but will not exclude possible matches. 

 Do not enter information that is not KNOWN as it may exclude match results that 
are desired. 

 Look at the possible check boxes on the search screen and select if they are 
appropriate for your search (some will be highlighted in module manuals). 

 

 

 

Select check boxes under the 

search parameters that are 

appropriate. 
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 Searches will return a maximum of 300 rows  

 Clicking on a column heading over a list of data 

will sort the data in ascending/descending order 

 Click “View All” to display all available rows. 
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Links, Icons, Buttons, and Mandatory Fields 
 

Navigate to the Purchasing module to see examples of links, icons, and buttons. A 
glossary of icons, buttons, and keyboard shortcuts is included at the end of this guide. 

 
Another way to navigate in VISION is by using the Menu links.  As long as you are 
navigating within the application, it is up to you how you choose to navigate. 
 
 
Navigation:  Purchasing > Purchase Orders> Add/Update POs 

 
 

 
  

 
 

 
 
 
 

 
Click 

Click 
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. 

 
 

  

Enter a PO number or 

leave blank to see the 

list of all POs available 

for the business unit. 

Click 
 

Click either the 

link or page tab 
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Click to display 

PO 
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This screenshot contains some examples of links, icons and buttons. 
 

 
 

 
 
 
 

 

At the bottom of each page there are function buttons (i.e. Save, Return to 

Search, Previous in List, Next in List, Refresh, OK, Cancel). The Notify 

button is not active for our application. 

The 

Th 

 

 

The Notify button is not active for our application. 

 

Change 

Order Icon 

Schedule Icon 

Line Details Icon 

Mandatory fields are indicated with an “*”. 

Additional fields may be required as part of your 

department procedures. 
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Chart of Accounts Overview 
 
Oracle/PeopleSoft stores chart of account information in segmented fields called 
chartfields.  The State of Vermont will be utilizing the following seven (7) chartfields; 
Business Unit (required), Account (required), DeptID (required), Fund (required), 
Program (optional), Project/Grant (optional) and Class (optional).  The chartfield values 
are used throughout the entire system, meaning the values entered on a voucher to 
pay a bill would be the same values that ultimately are recorded in the general ledger.  
Each of the chartfields will be discussed in detail below.  The policies and procedures 
governing updates and changes to the chartfield values will also be addressed in this 
section.   
 
 
 
 
 Chartfield Summary 
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Accounting Periods and Budget Periods 
The State of Vermont fiscal year starts July 1st and ends June 30th. Accounting period 
refers to a particular month/ date range in the fiscal year. 
  

Accounting 

Period 
Date Range 

Fiscal Year / 

Budget Period 

1 July 1-31, 2016 2017 

2 August 1-31, 2016 2017 

3 September 1-30, 2016 2017 

4 October 1-31, 2016 2017 

5 November 1-30, 2016 2017 

6 December 1-31, 2016 2017 

7 January 1-31, 2017 2017 

8 February 1-28, 2017 2017 

9 March 1-31, 2017 2017 

10 April 1-30, 2017 2017 

11 May 1-31, 2017 2017 

12 June 1-30, 2017 2017 

998*  June 30, 2017 2017 

1 July 1-31, 2017 2018 

  

 
 

* Period 998 is an adjustment period used to capture all year end adjusting and 
correcting entries for the year just ended. A June 30th date is used on most period 998 
transactions. 
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Chartfield Definitions 
 
BUSINESS UNIT - required:  
Broadly defined as an operating unit (department, office, or board) established 
statutorily or administratively.  Business units can be individual departments or divisions 
that need to segregate their financial data for accounting purposes or operational 
centers that segregate their operations for management purposes, including security. 
 
In VISION, a business unit is a component of security and thus can define a level of 
control that is significant and appropriate to the module you use.  For example, General 
Ledger business units are typically departments; Payables business units define rules 
for paying bills and security access to charge expenditures; Receivables business units 
define rules for receiving payments.  Each business unit shares the same configuration 
in a particular module; this configuration governs processing and accounting rules.  You 
can share business units across any combination of modules, or define them within just 
one module.  If your entire organization keeps only one set of books, you can use one 
business unit across all modules.  Departments with many operating units may use 
multiple business units for one or all of the sub-modules (i.e. multiple business units for 
Accounts Payable or Purchasing) and still have only one General Ledger business unit. 
 
Following are important concepts to remember with regard to Business Units: 
 
 Business Units are 5 numeric characters long.   
 Business Units are logically grouped in ranges to facilitate tree building and 

maintenance, as well as to allow spacing for future Business Unit additions. 
 Transactions are stored by Business Unit.  Users only have security access to the 

Business Unit(s) for their department/agency.  Your Business Unit value can default 
in where it is required based on your Operator Preferences. 

 The first two digits were aligned in the following manner: 
 

General Government  01 

Protection Persons, etc 02 

Human Services 03 

Employment and Training 
(Labor) 

04 

General Education 05 

Natural Resources 06 

Commerce and Development 07 

Transportation 08 

Component Units 09 

 
 
 



 Page 33 of 62 

 

ACCOUNT - required: 

Account chartfield classifies the nature of operational transactions.  It holds the detail 
coding values for assets, liabilities, equity, revenues, and expense/expenditure 
transactions. 
The Account field is 6 numeric characters long.  Accounts are numbered according to 
the following convention: 
 

Account Type 
Numbering 

Scheme 

Assets 1XXXXX 

Liabilities 2XXXXX 

Fund Equity 3XXXXX 

Revenues 4XXXXX 

Expenses 5XXXXX 

Expenses (AHS Grant Exp) 6XXXXX 

Other Financing Sources 70XXXX 

Other Financing Uses 72XXXX 
 

Fund – required: 

Fund chartfield maintains the fiscal and accounting entities in which financial resources 
and the use of those resources are grouped according to statute, regulation, or current 
accounting standards. 
 
Fund Chartfield Numbering Scheme: 
 The fund chartfield is five digits long (all numeric) 

 Funds are shared across the State (i.e. they will be stored under a SetID = STATE) 
 
Commonly used funds across State Government: 
 

Fund Number Fund Name 
 

10000 General Fund 

20105 Transportation Fund 

20205 Education Fund 

20405 Global Commitment Fund 

21% Special Funds 

22% Federal Funds 

3% Bond Funds 

4% Permanent Funds 

5%  Internal Service & Enterprise Funds 

60% Pension Trust Funds 

63%  Agency Funds 

64% Agency Funds 
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Department (Dept ID) – required: 

The DeptID ChartField contains the operational unit subdivisions. 
 
Chartfield Numbering Scheme: 

  DeptID’s are 10 characters long and numeric. 

  The first four digits are the same as the LAST four of the GL Business Unit number, 

with the exception of BGS capital constructions dept id’s. 
 

Program:   (required for some departments) 
Program Chartfield maintains a description and a set of objectives toward which 
activities and resources are directed. 
  The program chartfield is five digits long. 

  Under Set ID = STATE so they can be shared across business units. 

 

Class:   
The Class Chartfield will be used to track activities relating to programs and across 
program lines based on departmental, administrative, or legislative needs. 

  The class chartfield is five digits long. 

  Under Set ID = STATE so they can be shared across business units. 
 

Project:  
The Project Chartfield captures and controls project or grant information to which 
funding sources are applied. 

  Project ID’s are up to fifteen characters long, and can have any combination of 
numbers and/or letters. 

  Under Set ID = Business Unit so they cannot be shared among business units.  The          

same project cannot be located under different Set ID’s. 
  Can be used to only track expenditures, or; 

  Can be used to control expenditures by defining a budget specific to the project 
with the use of a funding source. 
 
The Finance and Management website has a listing of all Business units and Chartfields 
located on the following link:   
http://finance.vermont.gov/training-and-support/vision-chartfields-and-accounting-
periods 
 
 
  

http://finance.vermont.gov/training-and-support/vision-chartfields-and-accounting-periods
http://finance.vermont.gov/training-and-support/vision-chartfields-and-accounting-periods
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Budget Check Errors 
 

This table of budget check errors may be encountered in any module where budget 
checking is processed. 
 

Description Explanation 

Exceeds Budget 
Tolerance 

There is not enough spending authority in the budget to 
post the transaction. 

No Budget Exists There is no organization budget OR appropriation and 
organization budget set up for the fund and deptid 
combination used on the transaction.  

Budget is Closed The transaction is trying to post to a closed prior year 
budget. 

Budget Date is Out 
of Bounds 

The accounting date on the transaction is either in a 
future period or prior fiscal year that is closed. 

Spending Authority 
Over Budget 

A credit transaction to an expense account will cause the 
spending authority to exceed the original budgeted 
amount; i.e. there are not enough expenditure’s in the 
current year to offset the credit. 

Budget Date is 
Outside Specified 
Dates 

The transaction is trying to post to a budget that is no 
longer available to be posted to. 
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DeptID Search/Selection (Example) 
 

Navigation: Asset Management > Financial Management> Owned Assets > Express 
Add 
 

 
 

 
 

Click 

Click on the 

magnifying glass 
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ALL DeptIDs are displayed. 
Tip: To view DeptIDs for your BU only, enter the first 4 

digits of your BU (without the leading 0) before clicking on 

the magnifying glass 
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Reporting Tools 
 

There are four different types of reports that can be run in VISION.  They are Query 
Reports, nVision Reports, Crystal Reports, and Structured Query Reports (SQR). 
 
 
Detailed instructions on how to run each of the types of reports can be found on the 
Finance & Management Website at the following link:     
http://finance.vermont.gov/training-and-support/vision-manuals/reporting-manual 
 
For a list of all available queries visit the Finance & Management Website at the 
following link: 
http://finance.vermont.gov/training-and-support/vision-manuals/reporting-manual 
 
 
The queries and reports are listed by module so click on the module to view the reports 
and queries that pertain to that module.  (Remember, this is just a listing of queries for 
that module and is not a complete listing of all queries.) 
 
Also on the Finance and Management Website you will find Month End Closing 
Instructions which contain VT_MER queries to run for each module for month end clean 
up. 
 
http://finance.vermont.gov/policies-and-procedures/vision-closing-instructions 
 
 
 
  

http://finance.vermont.gov/training-and-support/vision-manuals/reporting-manual
http://finance.vermont.gov/training-and-support/vision-manuals/reporting-manual
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Query Viewer 

 
Use the following navigation to access existing queries. 
Navigation:  Reporting Tools > Query> Query Viewer 
 

 
 

 

 
 

 

 

 

Enter “VT” to display 

public queries. 

To display more 

search results click on 

the right arrow icon. 

To run a query, click 

on Excel. 
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Enter appropriate data in parameter boxes displayed. All fields must have a value and 
the % can be used as a wildcard.  The % sign can be used to help narrow down the 
information that you are looking for.  For example, if the box is asking you for Deptid 
information and you want information on all deptid’s within that business unit (01110) 
you can enter 1110% and that helps to narrow down the search information and the 
query should run faster. 
 
Caution:  Be careful in what fields you use the % sign.  You would not want to run an 
expenditure query for the fiscal year and put % sign under business unit because the 
report would be too large and it would eventually time out. 
 
If you do have a situation where you have a query that continues to run and you want 
to cancel the query please call the VISION Support Team at 828-6700, option 2.  They 
will make sure that the query does not continue to run behind the scenes causing 
system performance problems.   
 
 

 
 

 

Click 

Some queries may have minor changes in the displayed results. For example, 

VT_ACCOUNT_EXP_ALLFIELDS_SUM amounts will have an extra digit in the 

“cents” column. You can format in Excel if needed. 
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Creating Query Favorites 
 

To create a list of your most commonly used queries, select the query by clicking Add to 
Favorites.  A Favorites list will be displayed at the bottom of the page.  
 

Navigation:  Reporting Tools> Query> Query Viewer 
 

 

Click the Favorite 

link next to the query   
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The next time you access Query Viewer only your Favorites are displayed. You may 
search for additional queries if the one you need is not in your Favorites list. 

 

The Favorites list is displayed at the bottom of 

the screen. 
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Reports 
 

Detailed instructions on how to run different reports can be found on the Finance & 
Management Website at the following link: 
http://finance.vermont.gov/training-and-support/vision-manuals/reporting-manual 
 
For a list of all available queries visit the Finance & Management Website at the 
following link: 
http://finance.vermont.gov/training-and-support/vision-manuals/reporting-manual 
 

The queries and reports are listed by module so click on the module to view the reports 
and queries. 
 

Most delivered reports are run from within the module you are working in. These steps 
walk you through the process of running a report and viewing and printing it using 
Report Manager. (See each module training manual for common reports relative to the 
module.) 
 
Navigation:   Purchasing > Purchase Orders > Reports> Listings 
 

 
 

Enter a Run Control ID or search for an existing 

Run Control ID. 

NOTE: Run controls should not be shared 

between modules or processes.  For example, a 

run control created for the report PO listings 

should not be used for the report VT Contracts 

by Origin. 



 Page 44 of 62 

 

 
 

 

 

 

 

 
 

 

1st Enter information appropriate for the 

specific report.  

2nd Click Save if you 

want to keep these 

parameters for future 

reports. 

3rd Click Run to run 

the report. 

Select the check 

box next to your 

report – Click OK 
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Click 

1st 

Click 

3rd Click  

2nd Click 

Refresh until 

status = 

Posted 
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These steps for running Report Manager are consistent throughout the modules. 

Click 
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Process Monitor 

After you submit a job using the Process Scheduler Request page, you can track the 
process of the job by using the Process Monitor.  See example below: 

 

Use Process Monitor to review the status of scheduled or running processes.  

You can view all processes to see the status of any job in the queue. 

 

Use the Process List page to monitor the process requests that you submit. If a process 
encounters an error, or if a server is down, you can find out almost immediately. If your 

To view the status of 

your process click the 

refresh button until run 

status is Success and 

Distribution Status is 

Posted. 
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job runs to error, no success, or if the job has been processing for a long period of time 
call the VISION Support Team at 828-6700, option 2. 

You can also navigate to the Process Monitor by using the navigation below. 

Navigation:  People Tools> Process Scheduler> Process Monitor 

 

User ID - View the processes submitted by your User ID.  

 

Type - View by a process type, such as Application Engine, Crystal, COBOL, SQR, or 
Application Engine processes, or leave blank to view all processes. 

 

Server - View processes that are run on a particular server.  Servers – PSUNX or 
PSUNX2 for Application Engine and SQR Reports.  PSNT for Crystal and nVision 

Reports. 

 

Name - View processes by a process name, or leave blank to view all. 

 

Instance - To limit the view to a single request, enter the required instance ID in the 
first text field, or leave blank.  

 

Run Status - View processes by status, such as Success, Error, or leave blank to view 

all. 

 

To view the status of 

your process click the 

refresh button until run 

status is Success and 

Distribution Status is 

Posted. 
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Refresh - Click to check the current status of a submitted process.  Processes should 

run to a Run Status of Success and a Distribution Status of Posted. 

 

Instance - Displays the process instance; that is, the order in which the process 

appears in the queue. This number is automatically generated.  

 

Process Type - Displays the type of process, such as Application Engine, COBOL, or 
SQL. 

 

Process Name - Displays the name of the process. 

 

User - Displays the user ID of the person who submitted the request. 

 

Run Date/Time - Displays the time and date at which the process request was 

created. 

Run Status  - Indicates the status of the process, such as Queued, Initiated, 
Processing, Success or Cancelled. The Run Status column on the Process List page 
indicates the current state of a process. Knowing the status of a job helps you 
determine where it is in the queue or identify a problem if the process has an error.  

Distribution Status - Displays the distribution status for each individual job and 

process. Valid statuses are: N/A, Not Posted, Posting, and Posted. 

 

Details – Click Details link to display the Process Details page. 

 

 

 Process Detail page is displayed 
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Use the Process Detail page to view details, such as message logs, or View Log Trace. 

Process Section - This display-only group box contains general descriptive information 
to help you identify the process request, including the run and distribution states.  

 Instance - number automatically assigned to process.  If you report an issue to 
the Finance Support Team you should include the process number. 

 Name – Process name 

 Run Status – Current state of a process. 

 Queued – Status assigned to a new process request.  
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 Initiated – Indicates that the server has acknowledged the new                                                   
request. 

  Processing – Indicates that program is running 

  Warning – Warning status can occur for different reasons.  If a process 
runs to Warning, view the message log to determine why. 

 Error – Indicates that the program running has encountered an error.  If 
a process is in error please contact Finance Support @ 828-6700, option 
2. 

  No Success – Indicated that the program encountered an error.  
Contact Finance Support @ 828-6700, option 2. 

 Success – Indicates that the program has successfully completed. 

 Type – Process types are: Crystal, SQR Report, Application Engine, Cobol SQL, 
 PSJOB, and SQR. 

 Description – Brief description of process. 

 Distribution Status - N/A, None, Not Posted, Posting, and Posted. 

  

 Run Section 

 Run Control ID -  Displays the run control ID and the run location. 

 Location – Always shows Server.  

 Server - Displays the name of server utilized.  (PSNT, PSUNX, PSUNX2) 

NOTE:  If the server is blank contact the VISION Support Team at 828-6700, 
option 2 or email VISION.Finhelpdesk@vermont.gov. 

 

 Update Process Section – Used by Technical Staff only.    

 Date/Time Section – Process is tracked from beginning to end. 

 Actions Section – This group box contains links to other pages. 

 Parameters, View Locks and Batch Timings – Not applicable 

  

 

 

 

mailto:VISION.Finhelpdesk@vermont.gov
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 Message Log – example below is a message log for a voucher budget check.   

 

 View Log/Trace – Link takes you to View Log/Trace page where you can print 
 a SQR or Crystal report. 

 

Clicking on the PDF link will display your report or document. 
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Click the printer icon to print. 
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Clearing Cache in Internet Explorer 
 
 

VISION is a web based application that requires periodic maintenance to assist in the 
efficient running of the system. Clearing the computer’s cache (also called deleting 
temporary Internet Explorer files) is a frequently used maintenance tool.  
 
Your use of the web determines how often the cache should be cleared. A good 
practice is to clear cache at least once a week to avoid error messages such as “Page 
Cannot Be Displayed” when trying to log in or “invalid URL” when navigating. If you 
receive either of these messages follow these steps before calling Finance Support.  
 
Note: The following step-by-step instructions are for Internet Explorer 8. The version of 
Internet Explorer on your computer may look different, but the concept is the same. Any 
questions about your computer should be directed to your desktop support staff.  
 
 
 

Step 1 – Open or navigate to Internet Explorer  
 
 

Step 2 – Click on Tools  
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Step 3 – Click on Internet Options 

 

 
 
 

Step 4 – Under Browsing History, click Delete 
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Step 5 –Delete Temporary Internet Files, Cookies, and History are selected. 

(Instead of deleting each section individually, you may use ‘Delete’) 
 

 
 

A Delete Browsing History box will appear showing the deletion in progress. 
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Step 6 – Click OK 
 
 

 
 
 
 

Following these steps will clear the internet files and most often removes any cause of 
particular error messages. If this does not resolve the issue, contact VISION Finance 
Support at 828-6700, option 2. 
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Logging Out 
 

Before logging out, be sure that all of your work is saved or processed.  
 

 
 

 

 
 
Following these steps ensures that your login has completely disconnected from the 
PeopleSoft applications and servers. 
 

 

 

 

 

 

 

 

 

 

 

 

 

Click Sign Out  

Click   

Congratulations! 

You have completed VISION 101 
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Buttons and Icons Glossary 
 

 

 Change Order - To initiate the change order process on PO 
 

 Line Details/Schedule Details – To view/update the line/schedule details of a PO.  
Whether its line or schedule details is determined by the page the icon is 
accessed from. 

 

 Line Comments – To enter/view comments relating to a specific line of a 
transaction 

 

 Schedule – To access the schedule information of a PO 
 

 Add Rows – To insert additional rows in a transaction 
 

 Delete Rows – To delete rows from a transaction 
 

 Distributions/Chartfields – To access the distribution information in a PO 
 

 Ship To Address – To view the existing Ship To Address or to enter a One-Time 
Address 

 

 Cancel – To cancel a transaction 
 

 Spell Check Comments – To spell check comments in transactions 
 

 Look Up – To view previously defined values for a field 
 

 Requisitions – To view the requisition that a PO came from, if applicable 
 

 Processing Circle 
 

  To refresh a transaction on your page 
 

  To save a transaction  
 

  To add a new transaction 
 

 To update/display a transaction 

javascript:submitAction_win0(document.win0,'PO_PNLS_WRK_CHANGE_HDR');
javascript:submitAction_win0(document.win0,'PO_PNLS_WRK_GOTO_LINE_DTLS$0');
javascript:submitAction_win0(document.win0,'COMM_WRK1_COMMENTS_ICN$0');
javascript:submitAction_win0(document.win0,'PO_PNLS_WRK_GOTO_SCHED$0');
javascript:submitAction_win0(document.win0,'PO_LINE$newm$0$$0');
javascript:submitAction_win0(document.win0,'PO_LINE$delete$0$$0');
javascript:submitAction_win0(document.win0,'GOTO_DISTRIB$0');
javascript:submitAction_win0(document.win0,'GOTO_SHIP_ADDRESS$0');
javascript:submitAction_win0(document.win0,'PO_PNLS_WRK_CANCEL_PO_PB');
javascript:submitAction_win0(document.win0,'PO_HDR_A_COMMENTS_LONG$spellcheck$0');
javascript:submitAction_win0(document.win0,'PROJ_ID$prompt$0');
javascript:submitAction_win0(document.win0,'PO_LN_DIST_REQ_REQ_ID$popup$0');
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  This button is not currently used by SOV 
 

  To dispatch a PO 
 

 Return to the search functionality of the page 
 

  Move to the next item in the list 
 

 Move to the previous item in the list 
 

  This button is not currently used by SOV 
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Keyboard Shortcuts 
 
To view a list of keyboard shortcuts press CTRL+K, when you are on a search or 
transaction page. 
 
 
 

 
 

 

Press CTRL + K 
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This page will pop up in a separate window.  

Click the Print link 

for a hard copy of the 

list   


